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about this Guide

This guide provides a basic overview of using endNote. It assumes that you know how to use 
your word processor and the Windows operating system. for help on these topics, consult 
the documentation that comes with these products.

for additional information about using endNote, consult endNote Help. from endNote’s 
Help menu, select Contents to view help topics. While using endNote, press f1 to view a 
help topic about the current window.
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EndNote — Your Complete Reference Solution! 

endnote as an online search tool 

Search online bibliographic resources and retrieve references directly into  
your endNote library. You can also export references directly to endNote  
from your favorite online resource.

endnote as a reference and full text organizer with a collaborative Web tool

•	  Synchronize references and file attachments to your endNote online account. 

•	 Group references according to your research projects and attach 
up to 45 files per record for managing related materials. 

•	 Locate full text Pdf documents or create a reference when importing a Pdf file.

•	 Import and rename Pdf documents.

•	 Share groups with other endNote users easily and 
manage your ResearcherId publication list.

endnote as a bibliography maker

Cite While You Write takes the pain out of citing and formatting references in microsoft 
Word and Apache openoffice 3.x for Windows. You can also create bibliographies for 
other word processors using format Paper (RTf files).

What’s New in EndNote X7 
•	 Update and synchronize the references in endNote desktop and web by the click 

of a button. maintain and synchronize the references in your desktop library 
with the references in your web library even across multiple computers.

•	 Set your preferences to create clear, organized, and easily 
searchable names for your Pdf documents as you import them 
by defining your settings in Pdf Handling preferences.

•	 Add citations and reference lists to your microsoft PowerPoint slides. 

•	 Add subheadings to your bibliography in microsoft Word using your 
own categories or predefined by reference type in an output style 
great for distinguishing primary and secondary sources.

•	 Better organize your research materials by using new reference types 
such as Interview, Podcast, Conference Paper, and Press Release.

•	 Reorder column headings in the Library reference list by using drag-and-
drop and customize which columns display with just a right-click.

•	 Use improved Sync that occurs in the background so that your work is 
continuously backed up and always available online and on your iPad.

•	 Quickly identify groups online from within your desktop library

•	 Use new options to control the ratings and read/unread field display.

•	 Copy the record number to another field in a reference using the 
Copy feature from the Change\move\Copy fields command.

•	 Review program updates automatically.

activation Changes

macintosh and Windows serial numbers and product keys are now cross-platform com-
patible. You can use the same key on three computers regardless of platform. Just down-
load the additional installers at http://endnote.com.

Reference manager (versions 8 - 12) can purchase endNote at the upgrade price and use 
their original upgrade serial numbers to unlock endNote.

education & training—View our What’s new Video  

Thomson Reuters recommends that you view our What’s New video at  
www.endnote.com/training or on our YouTube channel at  
www.youtube.com/endnotetraining.

ChaPter  1:  
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About the Demonstration Version 
of EndNote and the EndNote Viewer 
If you are working with the endNote demonstration version, you have 30 days after you first 
use the program to evaluate endNote and all of its features. After 30 days, the demonstra-
tion version reverts to a feature-restricted endNote Viewer. 

After the program reverts to an endNote Viewer, you can still open endNote libraries, 
search, sort, and print references. 

With the endNote Viewer, you will not be able to:

•	 Add or edit references in a library that has 10 or more references already in it. 

•	 format more than 10 citations in a paper. 

•	 Retrieve more than 10 references from a remote database. 

•	 Import more than 10 references. 

•	 export more than 10 references. 

•	 Sync across your desktop and web libraries. 

To purchase an unrestricted version of the endNote program, open your trial version, and 
then click the Yes button when the endNote dialog box appears with the message:

     “Would you like to activate the full version of endNote?”

You will need to purchase a product key in order to activate the unrestricted 
version of endNote.

If you are upgrading from a previous version of endNote, then you need to 
supply the product key and provide your name in the Name fi eld.

Customer Services 

register Your Copy of endNote  
Register your software by either 1) creating or upgrading your online account the first time 
that you start endNote or 2) by going to http://www.endnote.com/register. Registered 
users receive:

•	 free technical support

•	 Special upgrade offers

•	  Notification of new endNote versions that are compatible 
with the latest version of your word processor

endnote help 

online Help 

from endNote’s Help menu, select Contents to view the various topics. 
for context-sensitive help available on dialog windows, press the f1 key 
on your keyboard.

Compiled Help Pdf file

The online Help system is available as a compiled, printable Pdf document.  
You can find the file in the online help system in the help topic called overview  
of Thomson Reuters endNote.

It is also available at C:\Program files\endnote X7 and it is called  
endnoteX7Winhelp.pdf.

Release Notes 

for documentation updates and correction notes, refer to the readme.txt  
file installed in the endNote X7 folder.

Customer service 
Contact Sales for general product information, pricing, quantity discounts,  
and referrals to dealers. 

Contact Customer Service to order new copies or upgrades of endNote, 
to check billing/shipping status, and to register your software.

sales information
Phone: 1 800 722 1227 (Toll free)
Web/Email: http://www.endnote.com/contact

Customer support (orders, billing, and shipping)  
Phone: 800 336 4474 (country code is 01) (Press 3 at the prompt)
Fax: 215 386 2911 (country code is 01) 
Web/Email: http://www.endnote.com/contact

http://www.endnote.com/register.
http://lgdata.s3-website-us-east-1.amazonaws.com/docs/3854/940454/EndNoteX7WinHelp.pdf
http://lgdata.s3-website-us-east-1.amazonaws.com/docs/3854/940454/EndNoteX7WinHelp.pdf
http://www.endnote.com/contact
http://www.endnote.com/contact
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technical support 

Contact Technical Support if you encounter problems while using endNote. When you 
contact us, please have a clear description of the problem, and know the version of your 
Windows operating system, endNote, and word processor. To find the endNote version 
and serial number, start endNote and select About endNote from the Help menu. 

for web / e-mail or phone contact: 

•	 http://www.endnote.com/contact

for technical support tips:

Global Customer support Center

•	 endnote discussion forum 

international Customer and technical support 

for customer support or technical support outside of North America, 
visit our Web site to check for a local distributor. 

Go to http://www.endnote.com/distributors to find contact 
information for your local endNote support.

additonal information and support 

endNote marketing web Site 

Visit endnote.com for:

•	 free training options including online videos and Web classes

•	 Access to technical support knowledge base

•	 Information on the latest versions of endNote

•	 downloads for styles, filters, and connections

•	 And more …

endNote discussion Forums

If you wish to join an ongoing forum of endNote users like yourself, go to: 
http://community.thomsonreuters.com/t5/endnote/ct-p/endnote 

Join the endNote social network at the following Web sites:

•	 www.facebook.com/endnote

•	 www.twitter.com/endnotenews

•	 www.youtube.com/endnotetraining 

international Customer and technical support 

for customer support or technical support outside of North America, visit our  
Web site to check for a local distributor. 

Go to http://endnote.com/distributors to find contact information for your  
local EndNote support.

ada VPat 

Thomson Reuters is dedicated to developing software products that are usable for  
everyone, including those with physical challenges and disabilities. endNote is  
designed to adhere to the AdA (Americans with disabilities Act) Section 508  
accessibility standards.

Visit our Web site at http://www.endnote.com/vpat to access the VPAT (Voluntary 
Product Accessibility Template) document that describes the accessibility features 
that address the Section 508 Standards.

The VPAT is an informational tool developed by industry and government to help 
facilitate the understanding of compatibility issues under Section 508.

 
 

http://www.endnote.com/contact
http://www.endnote.com/distributors
http://www.endnote.com
http://community.thomsonreuters.com/t5/EndNote/ct-p/endnote
http://www.facebook.com/EndNote
http://www.twitter.com/EndNoteNews
http://www.youtube.com/endnotetraining
http://endnote.com/distributors
http://www.endnote.com/vpat
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this chapter covers the following topics. 

•	 Starting endNote and opening the examples library

•	 Navigating the Library window

•	 Working with endNote panels

•	 Selecting a Library window layout

•	 Sorting references

•	 Selecting and opening a reference

•	 Closing a reference

•	 Working with Pdf files

•	 Saving references to a custom group

•	 Sync your references, groups and attachments across your desktop and web account. 

Starting EndNote and Opening the Examples Library
from the Start menu, select All Programs > endNote > endNote Program 
to display the following dialog. 

1. from the file menu, select the open command.

2. Navigate to the examples folder in the endNote X7 folder  
in the Program files directory.

3. Select and open the compressed file called sample_Library_X7.enlx  
to extract the uncompressed library files called  
sample_Library_X7.enl and sample_Library_X7.data.

to create a new library

1. from the file menu, select the New command.

2. enter a name to identify your new library. 

3. enter the destination on your hard drive where you want to save your new library.

4. Click the Save button to save your new library.

Navigating the Library Window
When you open the sample library, you will see the Library 
window listing all of the references that the library contains. 

The Library window includes four work areas: 

•	 Groups panel

•	 Reference List panel

•	 Tabs panel

•	 Search panel

The options on the Tabs panel depend on the layout that you select  
from the Layout menu located in the lower right-hand corner.

ChaPter 2:   
workinG in an endnote library
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Working with EndNote Panels
Groups Panel

displays various groups of references for easy retrieval such as:

•	 Custom groups

•	 Smart groups

•	 Combination groups

•	 Permanent groups

•	 Temporary groups

reference List Panel 

displays a multi-column list of references. By default, the first column in the reference list 
shows a Read / Unread indicator followed by:  

•	 Paper clip icon (for references that include an attached file)

•	 Author’s last name, first name, initial (all names are shown)

•	 Year

•	 Title

•	 Rating

•	 Journal name or secondary title

•	 Reference type

•	 URL

•	 Last updated 

You can change the order of the fields by using the drag-and-drop method.  This is the 
easiest was to change the order.

You can also change the type of fields and the order of the fields that display in the list by 
going to Preferences and selecting display fields.

tabs Panel

displays:

•	 A Reference tab for editing a reference 

•	 A Preview tab for viewing formatted references

•	 An Attached Pdfs tab for viewing Pdf files

•	 A paper clip icon for attaching files to a reference

Preview Panel

You can see more details about a reference by highlighting the reference and selecting  
the Preview tab.

The Preview tab uses the current output style to display the selected reference as  
it is formatted in a bibliography. endNote’s output styles represent the rules for creating  
bibliographies for a variety of journals and other publications. The styles determine how 
your references look when you print, export, preview, or create bibliographies.

To select a different output style, go to the toolbar and select one from the  
output Styles menu. 

The output Style menu displays your “favorite” output styles, but you can choose Select 
Another Style to pick from other installed files. A typical installation installs only the most 
popular output styles, but more than 5,000 output styles are available in endNote.

reference Panel 

You can quickly edit your references by clicking on the Reference tab. most functionality is 
the same as working in the Reference window. enter text in a field by clicking on the field. 
All commands are available via the menus including contextual menus.

The Reference panel displays the contents of the highlighted reference. each part of the 
reference is stored in its own field. The reference type is displayed below the title bar.
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Pdf Viewer Panel 

open and view Pdf files attached to the current reference. See Working with Pdf files for 
more information.

search Panel 

Search for references from a particular endNote library. By default, the Search panel 
displays at the top of the endNote window. Click the Show Search Panel and Hide Search 
Panel buttons to toggle between the two views.

The Search panel consists of the following items:

•	 Logical operator List

•	 field List

•	 Comparison List

•	 Search fields

•	 Search Set List

•	 match Case

•	 match Words

To begin a search of your endNote library, select the group of references you want to 
search, and then go to the Tools menu and select Search Library.   

To begin a search of an online database, go to the Tools menu and select online Search. 

Selecting a Library Window Layout 
The options on the Library window depend on the layout that you select  
from the Layout menu located in the lower right-hand corner.

There are seven layout options from which to choose the layout view of the Library window.

Groups Panel  

Left / off: Select this layout to hide or show the Groups panel. Use this option  
in combination with any of the other layout options..

reference Panel  

right: Select this layout to combine the Reference, Preview, and Pdf Viewer tabs as one 
panel to the right of the reference list in a columnar arrangement. This is the default layout 
option.

right - split: Select this layout to arrange the Reference/Preview tabs and the  
Pdf Viewer panel to the right of the reference list in a columnar arrangement.

bottom: Select this layout to combine the Reference/Preview tabs and the  
Pdf Viewer tab in a split arrangement below the reference list.

bottom - split: Select this layout to combine the Reference, Preview, and Pdf  
tabs in one panel below the reference list.  

off: Select this layout to hide the Reference, Preview, and Pdf Viewer panels. 
endNote displays only the Groups panel and the reference list side- by-side.

Sorting References  
You can sort references by clicking on a column heading such as Author, Year, or Title. 

1. Click the Author column heading to change the current Author sort from 
ascending order to descending order.

2. Click the Year column heading to see the references sorted in descending 
order based on the year of publication.

3.  Click the Read / Unread column heading to sort either your Read or Unread 
references to the top.

4.  Click the Author column heading to return the sort order of the library to an 
alphabetical list sorted by the author names.
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Selecting and Opening a Reference 
You can work with specific references by selecting them in the Library window..

there are different ways to select a reference, such as:

1. Clicking on the reference using the mouse;

2. Using the arrow keys; or 

3. Typing the first few letters found in the field by which the 
library has been sorted.

To see how this works, click any reference to select it. 
Press the Up or down Arrow to select the previous or next reference.

to find and display a reference:

open the reference by Glover m. Allen by pressing the enter key or be selecting  
the edit Reference command from the References menu.

 The Reference window opens to display all of the information associated with  
the reference.This is where you enter or edit information for a reference. 

To view the rest of the reference:

•	 Use the mouse to scroll up and down the Reference window.

•	 Press the Tab key to move forward from one field to the next. 

•	 Press Shift+Tab to move backward through the fields. 

•	 Click the Show empty fields / Hide empty fields button to toggle between 
showing all fields in the reference or only those fields that contain data.

Closing a Reference  
You can close a reference in one of these ways:

•	 Click the X close button in the upper corner of the Reference window.

•	 from the file menu, select Close Reference. 

•	 from the keyboard, press Ctrl+W. endNote prompts you to save your changes.

•	 Note that many of the menu commands have a keyboard equivalent next to them.

Working with PDF Files 
You can open, annotate, and view Pdf files attached to the current reference.

1.  Select any reference in the Reference list.

2. Place your cursor inside the Pdf Viewer panel.

3.  Click the paper clip icon to open a file dialog. You can also press  
Ctrl+Alt+A to open a Select a file dialog.

4.  Navigate to the folder Program files/endNote X7.

5.  Select the check box titled “Copy this file to the default file attachment 
folder and create a relative link”. endNote makes a copy of the file to store 
with the library. The attached file is always available to you even when you 
move the library.

6. Select the file titled endnoteX7Winhelp.pdf. 

7.  Click open to insert the file into the selected reference.

You can attach up to 45 files.

Note that endNote automatically opens the first Pdf attached to a reference  
when you select the Pdf tab.

reference.This
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Pdf toolbar 

A toolbar appears within the Pdf Viewer panel that displays the following icons.

move your cursor over an icon on the toolbar to see Alt (hover) text to explain its function. 
for example, alt text for the first three icons displays:

•	 open Pdf file in the Reference Window

•	 Save Pdf

•	 Print Pdf

Right-click within an open Pdf file to display a contextual menu that includes many of 
these options plus other options, such as:

•	 open with Adobe Acrobat

•	 open in Reference Window

•	 e-mail Attachment

•	 Remove (deletes the current Pdf file)

•	 Show Notes / markup

•	 Hides Notes / markup

adding sticky notes  

1. Go to a section in the Pdf where you want to add a comment.

2.  Select the text where you want to insert a comment.

3.  Select the Sticky Note icon from the toolbar.

4. double-click the Sticky Note icon that appears in the Pdf file to  
display a Sticky Note text box.

5. enter your comments in the Sticky Note text box.

6.  Click the Save Pdf icon in the toolbar to save your changes.

highlighting text 

1. Go to a section in the Pdf where you want to highlight text.

2. Select the text within the Pdf that you want to highlight. 

3. Select the Highlight Text icon. The color of the selected text changes to yellow.

4. Click the Save PDF icon in the toolbar to save your changes.

Saving References to a Custom Group 
The left panel of the Library window lists groups of saved references. The first three groups 
are permanent. 

•	 All References displays all of the references in the library.

•	 Unfiled contains references that are not part of a custom group.

•	 Trash contains references that you have deleted from the library. 
They are not permanently eliminated until you empty Trash.

note: This section of the Groups panel will change after you initiate the Sync process for 
the first time. See Syncing Your Desktop Library With Your Online Account.

Below the permanent groups, you can create group sets to organize up to 5,000 custom 
groups, smart groups, and combination groups in the library.

•	 You build a custom group by adding individual references to the group. 

•	 endNote automatically compiles a smart group based on your search strategy.

•	 A combination group consists of references derived from a smart group 
search of the contents of existing custom and/or smart groups.

The sample library has several custom groups of references. Click the group 
names under the Bats group set in the left panel of the Library window to view 
the references in each group.
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to create a custom group and add references to it: 

1. Select one of the groups in the Bats group set.

2. from the Groups menu, select Create Group. 
In the Groups panel of the Library window, a group titled New Group is now 
highlighted for editing. 

3. Type Bats Behavior as the group name, and then press enter or click in the reference 
list area to save the change.

4. Select the All References group to display all references in the library.

5. In the Author column, highlight the reference by Glover m. Allen and the reference by 
Bat Conservation International.

6. drag the selected references to the new Bats Behavior group and drop them on the 
title of the group.

7. Select the Bats Behavior group to display the two references now included in the 
group.

 

to move the group to a different group set:

1. Select the group called Bats Behavior.

2. drag and drop the group anywhere in the my Groups group set.

to delete a custom group:  

1. Right-click on the group called Corvids to display a contextual menu, and then select 
the delete Group command. 

2. Click Yes when you are prompted to delete the group.

endNote deletes only the group. No references are deleted from your library. many of the 
commands for managing groups are available from the Groups menu and from the right-
click contextual menu.

Syncing Your Desktop Library with Your Online Account.
Your purchase of the endNote desktop software also includes access to endNote online 
with 5GB of file storage, unlimited reference storage, and group sharing. once you install 
your software, register at my.endnote.com. 

You must create an account to initiate the Sync process.

i already have an account 

1. Click the Sync button in the toolbar to go to the Login dialog. 

2.  enter your e-mail address.

3. enter your password.

4. Click OK to initiate the Sync process.

Since you already have an account, endNote populates the fields on the Sync Preferences 
page with the e-mail address and password. Later, you can change the data in these fields 
if you ever change your e-mail address or password.

The first time you sync, endNote will copy all references in each library to the other. If you 
have the same references in both libraries, these references will result in duplicates in the 
synchronized libraries.  

Use the Find Duplicates command under the References menu to find and remove dupli-
cates after your first synchronization.

i do not have an account   

If you do not have an account, then you must create one. Registration is fast and easy and 
activates your two-year access.  

http://my.endnote.com
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1. Click the Sync button in the toolbar.

2.  Click the Sign Up button to go to a User Registration dialog.

3.  enter an e-mail address in the User Registration dialog. 
Retype your e-mail address, and then click the Continue button. 

4.  enter your personal information in the required fields on the next User 
Registration form. for example, enter your name, a password, and a title.

5.  Select the appropriate radio button to Opt in or Opt out 
for e-mail communication. 

6.  Click the I Agree button indicating that you agree to the Terms and Conditions.  

once you create your account, endNote populates the fields on the Sync Preferences page 
with your e-mail address and password that you entered during registration. Later, you can 
change the data in these fields if you ever change your e-mail address or password.

sync status button

After the Sync process completes, the Groups panel includes a Sync Status button.

Click the button to open the Sync Status dialog to review information about the endNote 
library that you selected to synchronize with your online library. The dialog tells you the 
number of references and the number of file and figure attachments that endNote updated 
during the last Sync process.

sync Conflicts

If Sync conflicts occur during the Sync process, a Sync Conflicts group appears  
in the Groups panel.

A conflict occurs when you edit the reference in both desktop and web between Syncs.  
As a result, endNote does not know which one you want to keep.

Select the Sync Conflicts group to open the Resolve Sync Conflicts dialog where you can 
resolve conflicts between references in your library.
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this chapter covers the following topics. 

1. Setting Sync Preferences

2. Setting Pdf Handling Preferences

3. Setting display fonts Preferences 

Setting Sync Preferences
sync Preferences allow you to set your preferences and save  
your username and password. 

To access Sync Preference:

1. Go to the edit menu, and then select Preferences.

2. Select the Sync option.

3. Click the Enable Sync button to activate your account. 

See Syncing your desktop library with your online account for  
instructions on how to proceed or press f1 to open help on this dialog in endNote.

once you create your account, endNote populates the fields on the Sync Preferences page 
with your e-mail address and password that you entered during registration. Later, you can 
change the data in these fields if you ever change your e-mail address or password.your 
e-mail address or password.

ChaPter 3:  
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Setting PDF Handling Preferences    
Pdf Handling preferences allow you to define the automatic renaming process of Pdf 
documents that you want to import to an endNote library. You can create better  organized 
and easily searchable names for your Pdf documents as you import them into a library.

1. Go to the edit menu and then select Preferences. 

2. Select the PDF Handling option. 

 
 
 
 
 
 
 
 

3. Select how you want to rename your Pdf documents when endNote imports 
them into a library. The default value is don’t Rename. 
 
The Custom option allows you to create a personalized method of renaming Pdf 
documents when they are imported into a library

4. In the Pdf Auto Import folder panel, select the Enable automatic importing 
check box to enable automatic importing of your Pdfs into a library. 

5. Select a folder on your computer or create a new folder when the Browser for 
folder dialog displays.

6. Click OK to save your changes.

The “automatic” renaming process works in the background when you open an endNote 
library and while you are working in a library. The product stores all imported Pdfs in a 
group called Imported References in the Groups panel.

Setting Display Fonts Preferences 
You can select a different font to display text in the Library window and in   
the Reference window. 

1. Go to the edit menu, and then select Preferences. 

2. Select display fonts to display a dialog with four tabs. 
• The Library tab determines the font and size endNote applies to the  
 references listed in the Library window.  
 
• The General tab determines the font endNote applies when you enter text  
 in a field in the Reference, output Styles, Connection file, and Import filters  
 windows. It also determines the font endNote applies to text that you view in  
 the Previews panel or when you print and copy bibliographic information  
 from endNote.  
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• The Labels tab determines the font and size endNote applies to the 
 Reference window field labels.  
 
• The Search tab determines the font and size endNote applies when you enter 
 text in a field on the Search panel.

3. on the Library tab, click the Change Font button. 

4.  Select Tahoma or another font and font size. Close the fonts dialog, and then 
click OK to save the change.

5. on the General tab, click the Change Font button. 

6.  In the font list, select Tahoma or another font and font size.  
Click Apply to save the change.

7. Click OK to leave the Preferences dialog.

Note: keep in mind that Segoe UI, 8 pt is the default font and font size for  
Windows Vista and Windows 7, and Windows 8. Tahoma, 8 pt is the default  
font and font size for Windows XP.
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once a library is open, you can add a new reference to it:

1.  from the References menu, select New Reference to 
display an empty Reference window. 

New references appear as Journal Article, the default setting. You can change 
the reference type to another type using the Reference Type list at the top  
of the Reference window. You can also change the default reference type  
from endNote Preferences.

2. Select the Book reference type from the Reference Type menu. 
 
Notice that the field list changes to reflect the type of bibliographic information 
you would record for a book. Select other reference types from the list to see how 
the list of fields changes for each type of source. 
 
Note that three reference types (figure, Chart or Table, and equation) are 
available specifically for cataloging picture files and object files.  

You can add file Attachments, figures, and Captions to any reference type.  
 
Set the reference type back to Journal Article.

3.  enter author names for the reference. Individual author names must be entered 
one per line. 
a. enter a personal author name with the first name first. 
 With the cursor in the Author field, type: 
 
 Tiberius Rex 
 
 As you type, endNote suggests names similar to the one you are  
 entering. This is endNote’s way of using term lists to facilitate the    
 process of entering new references.  
 Note:  Turn on or off the auto-complete feature with endNote Term 
 List preferences. It is available for Author fields when you enter author 
 names with the last name first. 
 
  The name you are entering, Tiberius Rex, is a new author in  
  this library, so keep typing until you complete the name, and  
  then press enter.  
 
  The name appears in red text to indicate that 
  it is a new name in the  Author term list for this library. When 
   you close the reference, endNote adds the name to the Author 
  term list and the red text will change to black. 
  
b. enter the second author’s name, but with the surname first. 
 
 Morre, Nicole 
 
  This author’s last name is already in the sample library, so as 
  you start typing the last name, you will see endNote complete 
  the name for you. 
  Press enter to accept endNote’s suggested author name 

ChaPter 4:  
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c.  for the third author, enter: 
 
de Young, John Robert, Jr. 
  
The first comma separates the last and first name. The second comma is 
inserted before suffix text to make it clear that it is not part of the 
author’s name for manipulation of name order or stripping to initials 
Suffix text will always print after the other information for this author.  
 
Press enter.  
 
d. for the fourth author’s name, enter: 
 
University of California,, Berkeley 
 
Corporate author names are entered with a following comma, so they 
will not be manipulated like personal author names. In this case, the 
corporate author name has a comma within the name. We inserted two 
commas to allow for correct formatting. The first comma makes it clear 
that text up to that point should not be manipulated. The second 
comma indicates that there is no first name, yet includes suffix text

4.  Press Tab to accept the author name and move to the Year field. Type “2006” 
as the search term.

5. Continue entering the reference as shown below using the Tab key to move to 
the next field and Shift+Tab to move to the previous field. You can also use the 
mouse to click in the desired field. If information is not provided for a particular 
field, leave that field empty. 
 
Title: The scale and the feather:  
  A suggested evolution 
  
Journal: Paleontology 
 
Volume: 3 
 
Issue: 1 
 
Pages: 125-128 
 
Date:  November 22 

 
Keywords: Feathers 
   Evolution 
   Birds 
 
No extra punctuation (such as parentheses around the year) is entered into the 
reference. endNote adds the necessary punctuation to the references when it 
creates a bibliography.  
 
Note that you can enter up to 64 k of text into the Abstract and Notes fields, 
which amounts to 10-12 pages of text.

6.  Attach a Pdf file to the reference. You can attach almost any type of file to the 
file Attachments field of a reference. 
 
Scroll to the file Attachments field, and from the References menu,  
select file Attachments > Attach file to display a file dialog. on the file dialog: 
a. Navigate to the folder Program files\endNote X7.  
 
b. Notice the check box titled “Copy this file to the default file attachment  
 folder and create a relative link”. make sure that you select this box so that  
 endNote will make a copy of the file to store with the library.  
 That way, the attached file is always available to you, even 
 when you move the library. 
 
c. Highlight the file titled endnoteX7Winhelp.pdf.  
 
d. Click open to insert the file into the file Attachments field. 
 A file icon will appear in the field. 

 You can attach up to 45 different files to a single reference. double-click 
 the file icon to open the file with the default program for the file type.  
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7. Right-click to display a contextual menu. Select Attach file > Rename 
Attachment to display a Rename Attachment dialog. enter my endNote X7 Help.
pdf, and then click ok. 

8. Select a field from each of the three menus to change the order of the fields in 
the Pdf name.  for example, you can rename the Pdf by Title, Author, date or 
any combination of fields from the three menus.

9. from the file menu, select Close Reference to close the Reference window. 

10. When prompted to save your changes, click Yes. Your new reference will appear 
in the Library window. A paper clip icon appears next to the reference to indicate 
an attached file.

notes:

•	 In the Groups panel, one reference appears in the Unfiled group. 
Select the Unfiled group to display the Tiberius Rex reference.

•	 You can easily locate those references that contain attached files by 
clicking the paper clip icon in the second column heading. endNote 
sorts all records containing attached files at the top of the list.

Help.pdf
Help.pdf
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this chapter covers the following topics. 

•	 Searching for a set of references 

•	 Creating a smart group 

•	 Creating a combination group

Searching for a Set of References
Let us assume that you want to generate a list of all references found in the sample library 
on Bats that were published from 2000 to 2013.

1. Select the All References group. 

2. Click the Show Search Panel button if the Search panel is not already showing.

3. on the first search line: 
a In the field list, scroll up and select Any field. This means 
 that endNote will search all fields. 
b. In the Comparison list, the Contains comparison operator means 
 that endNote will search for the string of text anywhere in a field. 
c.  Type “bats” as the first search term.

4. from the field list in the second search line, select Year. from the Comparison 
list, select “Is greater than or equal to” and then type “2000” as the search term.

5.  from the field list in the third search line, select Year. from the Comparison list, 
select “Is less than or equal to” and then type “2013” as the search term. 

6.   Notice the “And, or, Not” logical operator list at the beginning of each search 
line. Select the “And” logical operator between the three search lines.  
 
The Search panel should look like this. 

This search will find all references published between 2000 and 2013 that 
contains the text “bats”.  
 
Notice that the following check boxes are not selected for this search: 
 
Match Case: This option would limit our search to “bats” in lowercase. If it were 
found capitalized at the beginning of a sentence, or all uppercase, it would not 
match the search. 
 
Match Words: This option would limit matches to full words with no truncation. 
The word “batsman” would not match our search.  
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7. Click the Search button to begin the search. In a moment, endNote displays 
the search results. 
 
The status area at the bottom of the Library window should read, 
“Showing 17 of 17 references in Group”. 

Notice in the Groups panel that endNote automatically retains the results 
in a Search Results group set. This makes it easy to display other sets of 
references, but still go back and display your most recent search results. 
endNote replaces this temporary Search Results group the next time you run a 
search on the library. When you close the library, endNote removes the group. 
 
As you enter additional references into your library, you may want to keep 
track of the references that meet your search criteria. An easy way to do this is 
with a smart group. 

Creating a Smart Group 
You could create a custom group, and then drag your search results to the group, but 
as you entered new references into your library, you would need to keep updating the 
custom group. Instead, create a smart group that updates automatically.

The Search panel should still display the search strategy to find “bats” for publication 
years 2000 to 2013.

to use the search strategy to create a smart group:

1. Select the Bats group set. 

2. Click the options button on the Search panel, and then select Convert to 
Smart Group. 
 
A Converted Search text box appears under the group set called Bats.

3. Type “Bats 2000-2013” to replace the Converted Search title, and then press 
enter. 
 
If you have already clicked away from the editable title, you can right-click on 
the title, and then select Rename Group. 
 
each time you add a reference to the library, endNote updates the  
smart group as needed. 

Creating a Combination Group 
Let us assume that you want to combine all your custom groups and smart groups under 
the Bats group set in order to better organize your endNote references. You can do this 
and use ANd, oR, and NoT logic to create new, useful combined group sets.

to create a combination group:

1.  Select the Chiroptera custom group from the Bats group set.

2. from the Groups menu, select Create from Groups to open a dialog.
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3.  In the Group Name field, type “Chiroptera Combo Group.” 

4. Go to the “Include References In” fields section of the dialog. In the first field, 
select Chiroptera from the Bats group set menu.

5. In the second field, select echolocation from the Bats group set menu. Select the 
oR Boolean from Logical operator list.

6. In the third field, select the Sonar smart group from the Bats group set menu. 
Select the oR Boolean from the Logical operator list.

7. Click the Create button to save your changes. Your combination group should 
appear in the Groups panel.

Your combined group should contain 24 references from the following custom  
groups and smart groups.

•	 Chiroptera

•	 echolocation

•	 Sonar 
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With the online Search command, you can search online bibliographic databases  
just as easily as you can search an endNote library on your own computer. You can  
download the results of your searches into a temporary endNote library or directly  
into your own endNote library.

This chapter covers the following topics. 

•	 Selecting a display mode

•	 Searching a database

•	 Reviewing references 

•	 deleting references

•	 finding full text for a reference

Selecting a Display Mode
Choose from three different display modes in the Library window by selecting  
one of them from the toolbar. 

 
 

Local Library Mode

This mode displays automatic groups, custom groups, and smart groups, but not online 
Groups. This mode keeps you from inadvertently downloading references found during an 
online search into your currently open library. This is the default mode.

online search Mode 

In this mode, only the online search groups are available. When you download  
references from an online database, the references are stored in a temporary library  
until you save them to a permanent library. You can then review the references without  
affecting your local library.

integrated Library & online search Mode

In this mode, all local library commands and groups are available. When you download  
references from an online database, endNote saves them to a group under the online 
Search group set and to your open library.

If you decide that you do not want to keep the retrieved references, select them, and then 
move them to the Trash folder.

note: We recommend that you use online Search mode if you do not want the references 
downloaded to the All References group. Searching a database 

Searching a Database 
The next step is to enter the search terms to find the references you need. Searching an 
online database is very similar to searching an endNote library. 

1. Select online Search mode from the endNote toolbar.

2. In the Groups panel, select Pubmed (NLm) group. 
 
You can also go to the Tools menu, select online Search, and then select 
Pubmed (NLm) from the Choose a Connect dialog.

ChaPter 6:  
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3. Set the field list for the first line to meSH Terms, and enter “fossil” in the 
search field. The Comparison list for online searches is always set to Contains.

4. Click Search.  
 
endNote sends the search request off to the Pubmed online database and 
displays a summary of the search results. 
The dialog box displays the number of references that endNote found to 
match your search request and gives you the option to retrieve them.  

 
If the results seem too many, you can refine the search by clicking the Cancel 
button.

5. Click Cancel to return to the Search panel.

6. Set the operator at the beginning of the second search line to And.

7.  In the second search line, select All fields from the field list and type 
“trilobite” as the search text..

8. Click Search. 
This time the system finds fewer references.

9. Click ok to retrieve and save the matching references.  

endNote downloads the references to the All References group and to a  
temporary Pubmed (NLm) group.

notes:  

•	 The Pubmed Web site is updated regularly, so you may find a 
different number of references than illustrated here..

•	 The temporary Pubmed (NLm) group will reset back to 
zero references when you close the library.
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Reviewing References  
Select the references that you want to keep and copy them to a permanent library.   
You may find that some of the references are not helpful for your research.

While you could open each reference individually to scan through the bibliographic data, 
you can also use the Preview panel or the Reference panel.

to review the new references:

1. Select a reference from the Reference list.

2. Click the Preview tab to display the reference.

3. Select the Show All fields output style from the output Style list.  
 
The Show All fields style is not bibliographic, but represents all of the  
fields in your references. on the Preview tab, scroll through the data  
in the selected reference.

Note:  If Show All fields is not in the output Style list, then choose “Select another 
Style” to go to the Choose a Style dialog. Select Show All fields from the list.

Finding Full Text for a Reference  
many online sources now supply both bibliographic information and the full text of the 
document you are referencing. endNote locates full text files on the Web by using data 
stored in your references. once found, endNote downloads and attaches the files to the 
references.

Note that you can find the full text for a single reference or up to 250 references.

to find the full text for a reference:

1. Select Local Library mode from the endNote toolbar.

2. Sort your references by author name in ascending order.

3. Select the first 10 references in the reference list. 
 

4. from the References menu, select find full Text > find full Text. 
 
endNote displays a copyright notice advising you to adhere to downloading 
and usage guidelines as required by your information provider. We will use 
the default endNote settings to search public sources that do not require 
authentication for access.

5. Click ok to begin the find full Text search. 
 
In the left-hand column, under the find full Text group set, you will see a 
Searching group indicating that a search is in progress. This search can work 
in the background, so if you had many references selected, you could continue 
working in your library. 
 
When the find full Text search is completed, endNote removes the Searching 
group. depending on the results, you may see a combination of three different 
groups under the find full Text group set. 
• found Pdf 
• found URL 
• Not found 
 
In this case, endNote was able to locate a Pdf 
file for five of the references and one URL. 
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In the reference list, you can see that each of the five references now has a paper clip 
icon next to it indicating an attached file. 

Select one of the references in the Library window, and then click the Pdf tab to open 
the Pdf file in the Pdf Viewer panel.
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online searching is the easiest way to retrieve references from online databases,  
but not all information providers offer this option. 

If you have access to an online bibliographic database or university catalog, you can  
probably use endNote’s import filters to import text files saved or downloaded from these 
sources. endNote filters are configurable so they give you the flexibility to import the  
reference data you need and eliminate data you do not need. 

 this chapter covers the following topics. 

•	 Searching a database and saving the references

•	 Selecting an import filter and importing data into endNote

•	 downloading records from Pubmed

•	 exporting records from Web of Science

Searching a Database and Saving the References  
often when you search a database, the matching references display as text, with no clear 
indicator between each piece of bibliographic information. The Pubmed reference below, 
saved in a Citation format, is an example. There is no clear indicator for endNote to be able 
to differentiate a title from an address or an abstract

Science. 1966 Dec 9;154(3754):1333-1339.

Early Eocene Bat from Wyoming.

Jepsen GL.

A fossil skeleton of an early Eocene bat, the oldest 
known flying mammal, was found in southwest Wyoming. 
The bat is assigned to the new species Icaronycteris 
index of the suborder Microchiroptera. It was 
apparently of a young male whose body was buried 
in varved marls of the Green River Formation, on 
the bottom of Fossil Lake, about 50 million years 
ago. The bones, some as slender as a human hair, 
show a few “primitive” characteristics such as 
a clawed index finger and a complete phalangeal 
formula, but the bat was fully developed - an 
anatomically precocious contemporary of the dog-
sized polydactylous horse.

PMID: 17770307 [PubMed - as supplied by publisher]
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To use this information effectively, you must consistently tag each piece of the information 
so that endNote can direct it to the correct endNote field.

database providers typically offer several different download formats. Regardless of which 
system you are searching, you need to save the references in a tagged format to a text file.

for this section of the tour, we will use a text file of Pubmed references that we previously 
downloaded in the tagged medLINe format. The file pubmed_result.txt is provided in the 
endNote examples folder. A single reference in the file appears like this:

PMID- 18198331
OWN - NLM
STAT- MEDLINE
DA  - 20080116
DCOM- 20080313
LR  - 20081121
IS  - 0890-9369 (Print)
VI  - 22
IP  - 2
DP  - 2008 Jan 15
TI  - Understanding of bat wing evolution takes 
flight.
PG  - 121-4
AD  - Department of Genetics, Harvard Medical School, 
Boston, MA 02115, USA.
FAU - Cooper, Kimberly L
AU  - Cooper KL
FAU - Tabin, Clifford J
AU  - Tabin CJ
LA  - eng
GR  - F32 HD 052349/HD/NICHD NIH HHS/United States
GR  - R37 HD 32443/HD/NICHD NIH HHS/United States

PT  - Comment
PT  - Journal Article
PT  - Research Support, N.I.H., Extramural
PL  - United States
TA  - Genes Dev
JT  - Genes & development
JID - 8711660
RN  - 0 (Homeodomain Proteins)
SB  - IM
CON - Genes Dev. 2008 Jan 15;22(2):141-51. PMID: 
18198333
MH  - Animals
MH  - Chiroptera/*genetics
MH  - *Evolution
MH  - Forelimb/anatomy & histology
MH  - Fossils
MH  - *Genetic Variation
MH  - Homeodomain Proteins/*genetics
MH  - Wing/*growth & development
EDAT- 2008/01/17 09:00
MHDA- 2008/03/14 09:00
CRDT- 2008/01/17 09:00
AID - 22/2/121 [pii]
AID - 10.1101/gad.1639108 [doi]
PST - publish
SO  - Genes Dev. 2008 Jan 15;22(2):121-4.

     
You can map each tag to a corresponding endNote field. If the data are inconsistently 
tagged, or poorly delimited, it may not be possible to import all of the data accurately.

10.1101/gad
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Selecting an Import Filter and Importing Data into EndNote
once you have captured and saved your data file in a tagged format, you need to identify 
the proper endNote filter to import the data. There are hundreds of filters included with 
endNote. each filter is designed to read a specific tagged format from a specific informa-
tion provider.

to import the sample PubMed text file into the sample library: 

1. from the file menu, select Import file.

2. Click the Choose button to display a file dialog.

3. Browse to the endNote X7\examples folder, and then highlight 
and open the pubmed_result.txt file.

4.  from the Import option list, select other filters to display 
the list of filters supplied in the endNote filters folder.  
 
You may want to review the list to see what filters we include in the product. 
You can create new filters or copy and edit existing filters. 
 
note:  A Typical installation installs only the most popular filters, 
but there are hundreds available with endNote. 

5. Type “Pubmed” to jump to the filter in the list.

6. With the Pubmed (NLm) filter highlighted, click the Choose button. 

7. Leave the other two options at their default settings. 
duplicates: import all  
 
By default, a reference is considered a duplicate if the Author, Year, Title, and 
Reference Type match a reference already in the library. You can change the 
duplicates criteria under endNote Preferences. We will import all references 
regardless of duplicates. 
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text translation: no translation  
This option allows you to specify the text character encoding of the file you 
import. This is important when you import references in languages that 
include extended characters. You can also find the correct language encoding 
information by opening the text file in microsoft Word or another word processor.

8. Click Import to import the file. 
 
When the process is complete, newly imported references display in the 
Reference list. You can select the Preview tab to view the formatted references 
or can select the Reference tab edit new references. 

Notice that the focus in the Groups panel has switched from the All References 
group to the Imported References group.  
 
The Imported References group is a temporary group. It is replaced each time 
you import a new set of references. endNote removes the group when you 
close the library. The references themselves remain in the library unless you 
specifically delete them. 
 
note:  Select the Bottom Layout mode to view your new references as shown in 
the above sample screenshot.

Direct Export of Records from PubMed 
many information providers have a direct export option that allows you to send copies 
of references directly to an endNote library. The direct export process automatically 
selects an endNote import filter to map bibliographic information into the appropriate  
endNote fields. All you need to do is select the endNote library into which the data  
should be imported. 

1. Go to the Pubmed Web site in your Web browser at http://www.pubmed.gov.

2.  In the Search field, enter your search criteria to execute your search.

3. Click the Search button.

4. Select the needed results, and then select Citation manager  
from the “Send to” menu.

5. Click Create file to export your selected records directly to endNote. 
 
The selected Pubmed records will appear in a temporary group called Imported 
References in the Groups panel in your endNote library. Select the references 
and move them to a group within the library. 
 
note: endNote will remove the temporary library and all the Pubmed  
records if you close the endNote library before you moving them to one  
of your permanent groups.

Exporting Records from Web of Science 
You can easily export bibliographic records from the Web of Science platform.  
A subscription to Web of Science is required.

Go to the Web of Science search page and perform a search using the Topic, Title, and 
Author fields.

1.  from the Results page, click the check boxes to select the records 
that you wish to export to endNote.

2. Go to the output Records section of the page and select the option 
to output full Record in step 2.

3.  Click the endNote button. 
 

http://www.pubmed.gov
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4. on the Processing page, click the export button (Internet explorer) to export the 
records to endNote. If you are using firefox, select the open With radio button, 
and then click ok to export the records. 

5.  If a Choose destination dialog box opens, select endNote, and then click ok.

6. At this point, the endNote program opens, and the system exports the records to 
a temporary group called Imported References.

Searching for Surnames that Contain Particles and Spaces 
When searching a Web of Science product database (for example, Web of Science Core  
Collection), always add a connector to author names that contains particles and spaces. 

for example, to search for de bruyn a from the Search panel, enter the name in the Search 
field as de+bruyn+a to ensure that the product returns all relevant results.

To search for de la rosa, enter the name in the Search field as de+la+rosa. You can also 
add a first name to restrict your search, but do not add a connector between the first name 
and the last name. for example, to search for Mario de la rosa, enter in the Search field 
Mario de+la+rosa.
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Continue with this part of the tour if you use microsoft Word 2007, or 2010. 

endNote’s Cite While You Write feature inserts endNote commands into an endNote tab in 
Word 2007 and 2010 to give you direct access to your references while writing in microsoft 
Word. The Cite While You Write commands enable endNote to do bibliographic formatting 
to the document that is currently open in Word.

This chapter covers the following topics. 

•	 Inserting endNote References

•	 Selecting a bibliographic style

•	 editing a citation

Inserting EndNote References 
open a new document in microsoft Word

We are going to start entering some text and citations for this tour. This example as-
sumes that your output style is set for Annotated. If not, we will show you how to select 
an output style in Selecting a Bibliographic Style. 

1. enter the following text as though you were writing a paper. 
 
Bats 
 
Bats are mammals of the order Chiroptera from the Greek 
“hand” and “wing” whose forelimbs form webbed wings, 
making them the only mammals naturally capable of true 
and sustained flight.  
 
Place your cursor at the end of the sentence. That is where you 
will insert a citation.

2. from the endNote X7 tab, click the Insert Citation icon.

3. The find & Insert my References dialog box appears. Type the author name 
“Avila” in the text box, and then click find.  
 
endNote lists the matching references. 
The full name Avila-flores appears in the dialog. 
 
 

4. Click the down Arrow on the Insert button to display a menu. 

ChaPter 8:  
USinG endnote while writinG 
a PaPer in miCroSoFt word

http://en.wikipedia.org/wiki/Greek_language
http://en.wikipedia.org/wiki/Greek_language
http://en.wikipedia.org/wiki/Wing
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1. Select the Insert option. 
 
endNote inserts a citation and Instant formatting formats the citation 
in the currently selected style and adds it to a formatted bibliography 
at the end of the paper.  
 
endNote automatically creates a link from the citation to the bibliography. If you 
have multiple bibliographies (for example, one at the end of each chapter and 
one at the end of the document), you can link in-text citations to the reference 
list at the end of each section and/or chapter. See Selecting a Bibliographic Style 
for information on how to turn this feature on and off.

2. Add more text to the paper: 
 
Bats represent about 20% of all classified mammal 
species worldwide with about 1,240 bat species 
divided into two suborders. 
 
Place your cursor at the end of the sentence. That is where you will 
insert another citation.

3. from the endNote X7 tab, click the Insert Citation icon.  
 
 
 
 
 
 

4. Type the date “2008” into the text box, and then click find. endNote searches all 
fields and lists the matching references.

5. Highlight the reference by the author Holland. 
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1. Click the down Arrow on the Insert button to display a menu. 
Select the Insert option. 
 
Your document text should look similar to this example. 
 
Bats 
Bats are mammals of the order Chiroptera from the 
Greek “hand” and “wing” whose forelimbs form webbed 
wings, making them the only mammals naturally capable 
of true and sustained flight. Bats do not  
flap their entire forelimbs, as birds do, but  
instead flap their spread-out digits, which are  
very long and covered with a thin membrane or 
patagium. (Avila-Flores and Medellin 2004)  Bats 
represent about 20% of all classified mammal  
species worldwide with about 1,240 bat species 
divided into two suborders. (Holland, Kirschvink et 
al. 2008) 
 
Avila-Flores, R. and R. A. Medellin (2004). 
“Ecological, taxonomic, and physiological  
correlates of cave use by mexican bats.” Journal of 
Mammalogy 85(4): 675-687. 
 
Holland, R. A., et al. (2008). “Bats use magnetite 
to detect the earth’s magnetic field.” PloS One 3(2): 
e1676, 1671-1676. 
 
 
Note:  You can also insert citations in footnotes. first, use the appropriate 
Word command to create the footnote. Then, insert the endNote citation in 
the footnote. Word controls the placement and numbering of the footnote and 
endNote formats the citation based on the current style. 
 
 
 
 

Selecting a Bibliographic Style 
format your citations and bibliography as many times as you like, changing the output 
style and various other layout settings each time. 

1. from the endNote X7 tab, in the Bibliography group, click the bottom corner 
arrow to display a Configure Bibliography dialog. 
 
Select a bibliographic style.  
 

Styles contain instructions for how endNote will format citations and  
the bibliography. Some styles sequentially number citations, and then  
insert a numbered reference list at the end of the paper. other styles insert 
Author-date citations. 
 
As you can see, there are other formatting options available here. You can make 
changes that override the settings in the current output style.

2. The Annotated style should appear in the “With output style” field. If not, click 
the Browse button next to the field, and select the Annotated style. 

http://en.wikipedia.org/wiki/Mammal
http://en.wikipedia.org/wiki/Greek_language
http://en.wikipedia.org/wiki/Wing
http://en.wikipedia.org/wiki/Flight
http://en.wikipedia.org/wiki/Bird
http://en.wikipedia.org/wiki/Digit_(anatomy)
http://en.wikipedia.org/wiki/Skin
http://en.wikipedia.org/wiki/Patagium
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1. Click the Underline linked in-text citations check box so that our citations within 
a document are visible as hyperlinks with underlining and blue text.

2. Click ok to leave the Configure Bibliography dialog. 
 
endNote automatically updates the existing citations and regenerates the 
bibliography in the Annotated style.  
 
Your document text should look similar to this example.

 
Bats

Bats are mammals of the order Chiroptera from 
the Greek “hand” and “wing” whose forelimbs 
form webbed wings, making them the only mammals 
naturally capable of true and sustained flight. 
Bats do not flap their entire forelimbs, as birds 
do, but instead flap their spread-out digits, 
which are very long and covered with a thin 
membrane or patagium. (Avila-Flores and Medellin 
2004)  Bats represent about 20% of all classified 
mammal species worldwide with about 1,240 bat 
species divided into two suborders. (Holland, 
Kirschvink et  al. 2008)

Avila-Flores, R. and R. A. Medellin (2004). 
“Ecological, taxonomic, and physiological 
correlates of cave use by mexican bats.” Journal 
of Mammalogy 85(4): 675-687.

Holland, R. A., et al. (2008). “Bats use 
magnetite to detect the earth’s magnetic field.” 
PloS One 3(2): e1676, 1671-1676.

Note: In the future, if you need to make changes to the paper such as 
adding or deleting citations or text, just do the necessary updates in 
your paper. If you want to change the output style or bibliography layout 
settings, select the Configure Bibliography command again. endNote will 
reformat the in-text citations and generate a new bibliography based on 
your changes.

Editing a Citation 
If you directly edit a citation or the bibliography, the changes will be lost when you select 
the Configure Bibliography option again because endNote reformats according to the rules 
of the selected output style. To make and retain changes to all citations and/or the bibli-
ography, modify the output style. However, if you want to make a change to an individual 
citation, select the edit & manage Citation(s) option.

for some bibliographic styles, the majority of references are cited in an “Author, date” 
format; but if the author’s name is mentioned within the paragraph text, the style dictates 
that the name not be repeated in the citation.

1.   Click anywhere on the Avila-flores citation.

2. from the endNote X7 tab, click edit & manage Citation(s). 

3. Select the edit Citation tab.

4.  from the formatting menu, select the exclude Year option.

5.  Leave the Prefix, Suffix, and Pages fields blank.

6.  Click ok to update the citations in your paper.

http://en.wikipedia.org/wiki/Mammal
http://en.wikipedia.org/wiki/Greek_language
http://en.wikipedia.org/wiki/Wing
http://en.wikipedia.org/wiki/Flight
http://en.wikipedia.org/wiki/Bird
http://en.wikipedia.org/wiki/Digit_(anatomy)
http://en.wikipedia.org/wiki/Skin
http://en.wikipedia.org/wiki/Patagium
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1.  Click anywhere on the Holland citation within Word.

2.  from the formatting menu, select the exclude Year option.

3.  Click ok to update the citations in your paper. 
 
Your document text should look similar to this example. Note that the date is 
gone from the Avila-flores citation. 

Bats 
 
Bats are mammals of the order Chiroptera from the  
Greek “hand” and “wing” whose forelimbs form 
webbed  
wings, making them the only mammals naturally  
capable of true and sustained flight. Bats do not  
flap their entire forelimbs, as birds do, but  
instead flap their spread-out digits, which are  
very long and covered with a thin membrane or  
patagium. (Avila-Flores and Medellin)  Bats  
represent about 20% of all classified mammal  
species worldwide with about 1,240 bat species  
divided into two suborders. (Holland, Kirschvink 
et  
al.) 
 
Avila-Flores, R. and R. A. Medellin (2004). 
“Ecological, taxonomic, and physiological 
correlates of cave use by mexican bats.” Journal 
of Mammalogy 85(4): 675-687. 
 
Holland, R. A., et al. (2008). “Bats use 
magnetite to detect the earth’s magnetic field.” 
PloS One 3(2): e1676, 1671-1676.

 
 
As you are working, remember to save your document. You can continue adding text 
and bibliographic citations to your paper and endNote will continue adding to the list 
of references.

http://en.wikipedia.org/wiki/Mammal
http://en.wikipedia.org/wiki/Greek_language
http://en.wikipedia.org/wiki/Wing
http://en.wikipedia.org/wiki/Flight
http://en.wikipedia.org/wiki/Bird
http://en.wikipedia.org/wiki/Digit_(anatomy)
http://en.wikipedia.org/wiki/Skin
http://en.wikipedia.org/wiki/Patagium
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